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ATTENTION 
CET EQUIPEMENT COMPORTE DES COMPOSANTS ELECTRONIQUES NON PROTEGÉS ET TRES 
SENSIBLES AUX DEGATS CAUSES PAR L’ELECTRICITE STATIQUE. LES UTILISATEURS SONT 
INVITES A TOUJOURS SUIVRE LES PROCEDURES ANTI-STATIQUES STANDARD LORSQU’ILS 
INSTALLENT, MANIPULENT OU UTILISENT CET EQUIPEMENT.  

IL EST IMPERATIF DE METTRE CET EQUIPEMENT SYSTEMATIQUEMENT HORS TENSION AVANT DE 

PROCEDER A DES MODIFICATIONS DE CONFIGURATION, PAR EXEMPLE POUR RETIRER OU 

AJOUTER DES ACCESSOIRES OU CONNECTER CES DERNIERS A D’AUTRES EQUIPEMENTS. TOUTE 

INOBSERVATION DE CES INSTRUCTIONS PEUT ENTRAINER UNE DETERIORATION DE 

L’EQUIPEMENT FOURNI OU DES ACCESSOIRES QUI LUI SONT CONNECTES. L’UTILISATEUR ASSUME 

L’ENTIERE RESPONSABILITE DE LA COMPATIBILITÉ ELECTRIQUE DES PERIPHERIQUES QU’IL 

CONNECTE A CET EQUIPEMENT. 

CET EQUIPEMENT EST EXCLUSIVEMENT DESTINE A UNE UTILISATION PROFESSIONNELLE EN 

ENVIRONNEMENT D’EXPÉRIMENTATION. IL COMPORTE DES COMPOSANTS ET DES CIRCUITS 

ELECTRONIQUES VULNERABLES AUX DOMMAGES MECANIQUES OU PHYSIQUES. LES 

UTILISATEURS SONT INVITES A MANIPULER ET UTILISER CET EQUIPEMENT EN CONSEQUENCE. 

TOUTE DETERIORATION DE CET EQUIPEMENT RESULTANT D’UNE MAUVAISE MANIPULATION OU 

D’UNE MAUVAISE UTILISATION, NOTAMMENT, CETTE LISTE ETANT NON LIMITATIVE, UNE 

DETERIORATION STATIQUE, MECANIQUE, PHYSIQUE OU ELECTRIQUE, ANNULERA LA GARANTIE DE 

CET EQUIPEMENT.  

EN AUCUN CAS ALTIUM, SES DIRIGEANTS, CADRES, COLLABORATEURS OU AGENTS NE 

POURRONT ETRE TENUS RESPONSABLES DES DOMMAGES DIRECTS, INDIRECTS OU SPECIAUX (Y 

COMPRIS DE DOMMAGES RELATIFS A UNE PERTE DE BENEFICE, UNE PERTE D’ACTIVITE, UNE 

PERTE DE JOUISSANCE OU UNE PERTE DE DONNEES, UNE INTERRUPTION D’ACTIVITE, …), MEME 

SI ALTIUM A ETE AVERTI DU RISQUE DE TELS DOMMAGES RESULTANT D’UN DEFAUT OU D’UNE 

MALFACON DE CET EQUIPEMENT OU DE SA DOCUMENTATION. 

AVERTISSEMENT 
CET EQUIPEMENT EST EXCLUSIVEMENT DESTINE A UNE UTILISATION PROFESSIONNELLE EN 
ENVIRONNEMENT D’EXPÉRIMENTATION. IL GENERE ET PEUT IRRADIER DES FREQUENCES 
RADIO. IL N’A PAS FAIT L’OBJET D’ESSAIS VISANT A EVALUER SA CONFORMITE A LA 
REGLEMENTATION EN MATIERE D’INTERFERENCES AVEC LES FREQUENCES RADIO. LE 
FONCTIONNEMENT DE CET EQUIPEMENT PEUT PROVOQUER DES INTERFERENCES AVEC UN 
EQUIPEMENT DE COMMUNICATIONS OU AUTRE. LES UTILISATEURS DOIVENT ETRE AVERTIS DE 
CE RISQUE ET IL LEUR INCOMBE DE PRENDRE LES MESURES QUI S’IMPOSES POUR EMPECHER 
DE TELLES INTERFERENCES. 

 

Copyright © 2005 Altium Limited. 

Tous droits réservés. Vous êtes habilité à imprimer le présent manuel sous réserve (1) d’en faire un usage 
strictement personnel et de ne pas le recopier ou le diffuser sur un ordinateur relié à un réseau ou sur un 
média quelconque ; et (2) à n’apporter aucune modification au contenu du manuel. Toute reproduction non 
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autorisée, partielle ou totale, de ce document, par quelque moyen que ce soit – mécanique ou électronique 
– y compris sa traduction dans une autre langue, à l’exception de courts extraits destinés à des revues 
publiées, est interdite sans la permission écrite explicite d’Altium Limited. Toute reproduction non autorisée 
de cet ouvrage peut également être interdite par la loi. Les contrevenants pourront faire l’objet de poursuites 
pénales ou civiles et se voir condamnés à une amende et/ou à de la prison. Altium, CAMtastic, CircuitStudio, 
Design Explorer, DXP, LiveDesign, NanoBoard, NanoTalk, Nexar, nVisage, P-CAD, Protel, Situs, TASKING 
et Topological Autorouting, ainsi que leurs logos respectifs, sont des marques ou des marques déposées 
d’Altium Limited ou de ses filiales. Altera et Cyclone sont des marques déposées d’Altera Corporation. 
Xilinx et Spartan sont des marques déposées de Xilinx Inc. Toutes les autres marques, déposées ou non, 
auxquelles il est fait référence ici, sont la propriété de leurs titulaires respectifs, et aucun droit de marque 
n’est ici revendiqué les concernant. 
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A propos de ce manuel  

Ce document décrit l’utilisation des Cartes d’Evaluation LiveDesign d’Altium.  

Historique des révisions  

Date Version  N°. Révision   

29-10-04 1.0 Nouvelle version du produit  

Conventions de notation  
Ce document utilise les conventions suivantes. 
• «Field Programmable Gate Arrays» (FPGA) et «Complex Programmable Logic Devices» 

(CPLD) peuvent être respectivement désignés par le sigle FPGA ou CPLD  

• Les instructions interactives apparaissent en gras, par exemple : 
Continue (Continuer) 
«View » Devices» (Afficher » Composants) 

A propos des avertissements  

Ce manuel contient par endroit des mises en garde. 

 Les mises en garde sont présentées comme suit. 

Une mise en garde décrit une situation susceptible d’endommager vos logiciels, votre matériel ou tout 
autre équipement. Chaque mise en garde vise à assurer votre protection, veuillez le lire attentivement.
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Présentation de la Carte d’Evaluation LiveDesign  
Ce chapitre décrit les principales caractéristiques et possibilités offertes par la Carte d’Evaluation 
LiveDesign. 

La Carte d’Evaluation LiveDesign, moyennant une licence d’évaluation du logiciel de développement 
sur PC DXP 2004 d’Altium, vous permet d’évaluer et de constater l’ensemble des avantages que peut 
vous apporter LiveDesign en matière d’implémentation et de débogage rapides de vos conceptions 
FPGA. 

 
Figure 1. PC connecté à la Carte d’Evaluation LiveDesign 

Principales caractéristiques de la Carte d’Evaluation LiveDesign  
La Carte d’Evaluation LiveDesign a les caractéristiques suivantes : 
• Composant so FPGA * 
• Double RAM statique 256Kx16 bits ultra-rapide et configurable par le FPGA  
• CAN Sigma Delta stéréo à fréquence d'échantillonnage paramétrable par l’utilisateur  
• Deux hauts-parleurs miniature (stéréo) avec contrôle du volume 
• Jack audio 2,5mm pour sortie de ligne et casque avec contrôle du volume  
• Affichage LED 7 segments 6 chiffres  
• Horloge 50mHz fixe  
• Port série RS232 
• Port VGA 
• Port de souris PS2 Mini DIN  
• Port de clavier PC PS2 Mini DIN  
• DIP switch à 8 interrupteurs  
• Ensemble de 8 LED  
• Connecteurs d’expansion double E/S 20 broches avec liaisons de sélection d’alimentation électrique  
• Bouton TEST/RESET paramétrable par l’utilisateur 

* Plusieurs Cartes d’Evaluation LiveDesign correspondant à différents composants FPGA, par exemple 
Spartan-3 de Xilinx ou Cyclone d’Altera, vous sont proposées. Pour connaître la liste des Cartes 
d’Evaluation LiveDesign actuellement proposées, veuillez visiter www.altium.com/dxpcentral. 

Carte d'évaluation 

Port parallèle
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Présentation fonctionnelle de la Carte d’Evaluation LiveDesign 
 

Figure 2. Organigramme de configuration de la Carte d’Evaluation LiveDesign 
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Démarrage  
Dans ce chapitre, vous trouverez les instructions détaillées de branchement de la Carte d’Evaluation 
LiveDesign à votre PC et d’essai de la connectivité entre PC et Carte d’Evaluation LiveDesign. Nous 
vous recommandons de le lire attentivement avant d’entamer la procédure d’installation et de 
configuration. 

ATTENTION : lors de la manipulation de la carte, veuillez respecter les procédures anti-
statiques standard. Pour apporter la moindre modification à la configuration de votre 
carte, par exemple pour ajouter ou retirer un composant plug-in aux connecteurs 
d’expansion de votre Carte d’Evaluation LiveDesign, pensez à mettre le système hors 
tension. 

Contenu du package  

Figure 3. Contenu du package de la Carte d’Evaluation LiveDesign 

A – Carte d’Evaluation LiveDesign 

B – Manuel de Référence Technique de la Carte d’Evaluation LiveDesign 

C – Câble parallèle (DB25 - IDC 26 points)  

D – Câble pour connecteur utilisateur (IDC 20 points - IDC 20 points) (x2)  

E – Boîtier d’alimentation électrique  

F – Cordon d’alimentation    

Si l’un de ces composants est manquant ou vous semble endommagé, veuillez contacter le Centre 
Local ou le Revendeur Altium le plus proche. 

C D E

A 

F 

B
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Configuration requise  
Avant d’installer le logiciel, veuillez vous assurer que vous disposez de la configuration minimale 
requise, décrite ci-dessous. 

Système recommandé 
Pour optimiser les résultats de votre logiciel de conception Altium, nous vous recommandons d’utiliser 
un PC correspondant aux spécifications suivantes : 

• Windows XP (édition professionnelle ou familiale) ou Windows 2000 édition professionnelle  

• Processeur Pentium 4 de 2 GHz ou équivalent   

• 1 Go de RAM  

• Go d’espace disque  pour le logiciel + 1 Go pour les fichiers utilisateur 

• Deux moniteurs à résolution d’écran 1280x1024 

• Carte graphique couleur 32 bits, 64 Mo  

• Port parallèle. 

Configuration minimale requise  
Pour optimiser les résultats de votre logiciel de conception, nous vous recommandons d’utiliser un PC 
correspondant aux spécifications suivantes : 

• Windows XP (édition professionnelle ou familiale) ou Windows 2000 édition professionnelle  

• Processeur de 1 GHz 

• 512 Mo de RAM  

• 1 Go d’espace disque pour le logiciel + 1 Go pour les fichiers utilisateur) 

• Moniteur principal : résolution d’écran 1280x1024 

• Vivement recommandé : second moniteur avec une résolution d’écran minimale de 1024x768 

• Carte graphique couleur 32 bits, 32 Mo  

• Port parallèle. 
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Le logiciel de conception Altium  
Pour installer votre logiciel de conception Altium, vous devez disposer d’environ 1Go d’espace disque 
dur disponible. Pour entamer la procédure d’installation, il vous suffit d’introduire le CD contenant 
l’Installation du logiciel dans le lecteur de CD-ROM de votre ordinateur. L’Assistant d’Installation 
démarre automatiquement et vous guide à travers la procédure d’installation. 

Si l’Assistant d’Installation ne démarre pas automatiquement, veuillez lancer le programme Setup.exe, 
que vous trouverez dans le répertoire\Setup du CD. 

Lors de la première exécution du logiciel, vous devez l’activer. Pour ce faire, utilisez les options 
«Active License» que vous trouverez sur la page «DXP License Management».   

Une fois terminée l’installation du logiciel, vous devez installer les outils du constructeur du FPGA – 
s’ils ne sont pas déjà en place – puis connecter la Carte d’Evaluation LiveDesign à votre PC avant de 
lancer le système de conception. 

Vous trouverez la procédure détaillée d’installation du logiciel et d’activation de la licence dans le 
Guide de Démarrage Rapide du «LiveDesign Evaluation Kit». 

Remarque importante concernant les outils des constructeurs de FPGA  
Pour router le programme FPGA dans le FPGA cible sur la Carte d’Evaluation LiveDesign, vous devez 
utiliser les outils constructeur du FPGA. Or, ces outils NE SONT PAS livrés avec le système. Vous 
devez vous les procurer indépendamment. 

Avant de pouvoir télécharger un programme vers la Carte d’Evaluation LiveDesign, vous devez vous 
assurer que les outils du constructeur dont vous aurez besoin sont bien installés sur votre ordinateur. 

Chaque Carte d’Evaluation LiveDesign est livrée avec un FPGA cible pris en charge par les outils 
téléchargeables gratuitement du constructeur, que vous trouverez sur le web, ainsi que par les 
versions commerciales des outils en question. 

Pour de plus amples informations sur les outils du constructeur correspondant aux FPGA pris en 
charge, visitez le site web du constructeur en question. Pour obtenir des informations à jour sur les 
outils de constructeurs compatibles avec le logiciel Altium, ainsi que des liens vers les sites web 
associés, veuillez visiter www.altium.com/dxpcentral.  

Important : Altium n’assure pas le support technique des outils des constructeurs de FPGA. Pour 
obtenir des informations sur l’installation de ces outils, veuillez vous reporter aux informations fournies 
par les constructeurs proprement dits. 
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Installation de la Carte d’Evaluation LiveDesign  
La Carte d’Evaluation LiveDesign se connecte à votre PC à travers son port parallèle. La Figure 4 
représente la Carte d’Evaluation LiveDesign avec l’emplacement des principaux composants 
manipulés durant l’installation. 

Figure 4. La Carte d’Evaluation LiveDesign  
1 = Socket pour câble parallèle 2 = Socket pour le cordon d’alimentation électrique 
 

Pour démarrer la Carte d’Evaluation LiveDesign, veuillez suivre la procédure ci-dessous : 

1. Connectez la Carte d’Evaluation LiveDesign à votre PC à l’aide du câble parallèle fourni, en 
utilisant le socket pour câble parallèle, comme indiqué en Figure 4. 

2. Mettez la carte sous tension à l’aide du boîtier d’alimentation 5V courant alternatif et le cordon 
d’alimentation désignée en Figure 4. La LED d’alimentation doit s’allumer. 

1 

2
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Test de la connexion entre PC et Carte d’Evaluation LiveDesign  
Une fois que vous avez connecté la Carte d’Evaluation LiveDesign à votre PC, vous devez vous 
assurer que le logiciel système peut se connecter à la Carte d’Evaluation LiveDesign.   

La procédure pour le faire est la suivante. 
1. Lancez votre système de conception Altium en sélectionnant l’icône DXP 2004 depuis le menu 

Démarrer de Windows. 

2. A la première exécution du système avec une Carte d’Evaluation LiveDesign connectée, il se 
constitue une mémoire cache des composants programmables pris en charge. Une boîte de 
dialogue indiquant l’état d’avancement de la procédure, s’affiche. La mise en place de la mémoire 
cache peut prendre plusieurs minutes, en fonction de la puissance de votre ordinateur. Cette 
procédure n’est à exécuter qu’une seule fois. 

 
Figure 5. Compte-rendu d’avancement de la mémoire-cache des composants  

Une fois le système démarré, vous voyez apparaître la Page d’accueil de DXP 2004, illustrée en 
Figure 6. De là, vous pouvez sélectionner les nombreuses fonctionnalités proposées par le 
système. 

 
Figure 6. La Page d’accueil de DXP 2004 
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3. Cliquez sur l’icône «Device Management and Connections» (Gestion des composants et     
 connexions). 

La vue «Devices» (Composants) s’affiche. Vous pouvez également sélectionner «View » 
Devices» (Afficher » Composants) dans les menus. 

 
Figure 7. La fenêtre «Devices View». Remarque : ceci correspond à  
un composant Spartan-3 de Xilinx. L’image varie en fonction du composant FPGA cible 

4. Vérifiez que la case à cocher Live est sélectionnée et que l’indicateur Connected est vert. Ceci 
confirme que le système est connecté et qu’il communique avec la Carte d’Evaluation LiveDesign. 

  
 

5. Si le Composant indique que la Carte d’Evaluation LiveDesign n’est pas connectée, ou si aucune 
icône FPGA n’est visible, reportez-vous à la section Résolution des problèmes de connexion, plus 
loin dans ce manuel. Le message «No NanoBoards Found» (NanoBoard introuvable) s’affiche, 
mais ceci n’a aucune incidence sur l’utilisation de votre Carte d’Evaluation LiveDesign. 

Téléchargement d’un projet de test vers  
la Carte d’Evaluation LiveDesign  
Pour vous assurer que votre système de conception et votre Carte d’Evaluation LiveDesign sont 
installés et fonctionnent correctement, veuillez suivre la procédure ci-dessous pour compiler et 
synthétiser un exemple de projet et le télécharger vers la Carte d’Evaluation LiveDesign. Pour ce test, 
nous utiliserons l’exemple FPGA_LedChaser_EvalBoard.PRJFPG, que vous trouverez dans le 
répertoire \Program Files\Altium2004\Examples\LiveDesign Evaluation Board\FPGA Hardware\LED 
Chaser - Hardware. 
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1. Depuis les menus, sélectionnez «File » Open» (Fichier » Ouvrir). 
2. Naviguez vers le répertoire \Program Files\Altium2004\Examples\LiveDesign Evaluation 

Board\FPGA Hardware\LED Chaser - Hardware. 

3. Dans ce répertoire, ouvrez le fichier FPGA_LedChaser_EvalBoard.PRJFPG. Une fois le projet 
chargé, le panneau «Projects», situé à gauche de votre espace de travail, dresse la liste des 
fichiers du projet. 
Si la vue «Devices» n’est pas active, sélectionnez  «View » Devices» (Afficher » Composants) 
depuis les menus pour l’afficher. Le projet ouvert est automatiquement affecté au composant FPGA 
situé sur la Carte d’Evaluation LiveDesign active. La figure ci-dessous illustre cette situation sur 
composant Spartan-3 de Xilinx. 

Figure 8. La fenêtre «Devices View» montre le Spartan-3 de Xilinx  

4. Pour traiter le projet et le télécharger 
vers la Carte d’Evaluation LiveDesign, 
cliquez sur le bouton «Program 
FPGA» de la vue «Devices». 

 

Le système compile automatiquement les fichiers du projet source, synthétise la conception, 
appelle les outils de ‘place & route’ du constructeur afin de traiter la conception pour le FPGA cible, 
puis télécharge votre design vers la Carte d’Evaluation LiveDesign. Ceci peut prendre plusieurs 
minutes en fonction de la vitesse de votre ordinateur. 

  
Figure 9. La fenêtre «Devices View» montre l’avancement de la compilation 
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Important : En cas de blocage du système durant la procédure «Build», l’indicateur d’état passe au 
violet. Ce type de blocage peut être dû à une mauvaise installation ou à une mauvaise activation des 
outils du constructeur FPGA. Veuillez vous reporter à la documentation livrée avec les outils 
constructeur afin de connaître la procédure vous permettant de les installer et de les activer 
correctement. Pour de plus amples informations, veuillez visiter www.altium.com/dxpcentral. 

Une fois la conception téléchargée, l’ensemble des indicateurs passent au vert et la boîte de dialogue 
«Results Summary» (Synthèse des résultats) apparaît. Cet état indique que le projet a été 
correctement traité et téléchargé dans la Carte d’Evaluation LiveDesign. Vous pouvez à présent 
refermer la boîte de dialogue «Results Summary». 

 
Figure 10. La fenêtre «Devices» montre la compilation et le téléchargement réalisés avec succès 

Félicitations ! Vous venez de re-configurer votre Carte d’Evaluation LiveDesign en y intégrant un 
chenillard. Si vous regardez la carte, vous constaterez que le tableau de voyants lumineux situé au-
dessus du commutateur DIP 8 voies indique un mouvement. 

Veuillez noter que la vue «Devices» contient à présent des icônes représentant les instruments 
virtuels (modules d’E/S) qui fonctionnent sur la Carte d’Evaluation LiveDesign. 

 
Figure 11. La fenêtre «Devices View» montre les instruments virtuels 

Dans ce projet, les modules d’E/S permettent de contrôler le fonctionnement de la séquence de 
contrôle des voyants lumineux. Les icônes qui apparaissent dans la vue «Devices» indiquent que le 
système communique avec les instruments qui fonctionnent dans le FPGA, ce qui vous permet 
d’interagir et de contrôler les instruments pour le développement et le débogage. Vous pouvez 
examiner les schémas du projet FPGA_LedChaser_EvalBoard pour obtenir de plus amples 
informations sur la connexion et le fonctionnement des modules d’E/S virtuels. Double-cliquez sur une 
icône de module d’E/S dans la vue «Devices» pour accéder à la face avant de ce composant. 
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Résolution des problèmes de connexion  
Si la vue Devices vous indique que le système n’arrive pas à se connecter à la Carte d’Evaluation 
LiveDesign ou ne détecte pas la présence d’un FPGA sur la Carte d’Evaluation LiveDesign après avoir 
effectué la procédure de configuration et d’installation, la marche à suivre est la suivante : 

1.   Vérifiez que la Carte d’Evaluation LiveDesign est sous tension et que le voyant l’alimentation situé         
      à côté de la fiche d’alimentation électrique, est allumé. 

2. Assurez-vous que le câble qui relie la Carte d’Evaluation LiveDesign au PC est correctement 
branché à la fois au PC et à la Carte. 

3. En ayant la vue «Devices» active («View » Devices»), vérifiez que la case à cocher «Live» est 
sélectionnée. 

Si le système ne parvient pas à établir la connexion avec la Carte d’Evaluation LiveDesign et le 
FPGA après toutes ces vérifications, veuillez contacter votre Centre Local ou votre Revendeur 
Altium le plus proche. 
Important : Le système exige la présence, sur votre ordinateur, d’un port parallèle standard en bon 
état de fonctionnement. Sur certains ordinateurs, le port parallèle ne respecte pas strictement les 
normes en vigueur, ce qui peut provoquer des problèmes de communication avec la Carte 
d’Evaluation LiveDesign. Si possible, réinstallez le système sur un autre ordinateur pour voir si telle 
est la cause de votre problème. 

Que faire ensuite  
Une fois que vous avez suivi la procédure décrite dans ce guide, votre système est installé et prêt à 
l’emploi. Pour vous aider à vous familiariser avec votre système de conception et ses fonctionnalités, 
nous vous recommandons de vous reporter au Guide de Démarrage Rapide du  «LiveDesign 
Evaluation Kit» , où vous trouverez des exemples et des informations complémentaires. 



Carte d’Evaluation LiveDesign Manuel de Référence Technique  

12     

Caractéristiques & périphériques   
Ce chapitre décrit la Carte d’Evaluation LiveDesign, ses principaux composants et la manière dont ils 
interagissent. Il contient également des informations détaillées sur les diverses interfaces de la Carte 
d’Evaluation LiveDesign. Les schémas de la Carte d’Evaluation LiveDesign et les fichiers de PCB sont 
disponibles dans le dossier \Program Files\ 
Altium2004\Examples\LiveDesignEvaluationBoard\Reference Designs. Vous pouvez vous y reporter 
en dernier recours.  

Des exemples spécifiques figurent dans le dossier \Program Files\Altium2004\Examples\ 
LiveDesignEvaluationBoard\. Ils illustrent le fonctionnement de ces caractéristiques et périphériques. 
Pour de plus amples informations, des ressources de support ou des exemples complémentaires, 
veuillez vous reporter à www.altium.com/dxpcentral. 

La Carte d’Evaluation LiveDesign a été conçue à l’aide des éditeurs de schémas et de PCB d’Altium. Il 
s’agit d’une carte à circuit imprimé qui comporte six couches. La capacité de routage interne du FPGA 
utilisé sur la Carte d’Evaluation LiveDesign a permis un placement optimal des pistes du PCB, ce qui a 
réduit  le nombre de vias. La distribution de l’alimentation et de la terre est facilitée par une topologie 
en étoile. Toutes les zones de cuivre non utilisées ont été remplies par le plan de masse. 

Le PCB constitue un bon exemple des techniques nécessaires pour utiliser les FPGA à faible coût et 
vitesse moyenne avec empreintes BGA. 
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Description et caractéristiques de la Carte d’Evaluation LiveDesign  
La Figure 12 ci-dessous montre le routage de la Carte d’Evaluation LiveDesign, avec ses 
caractéristiques et ses périphériques. 

 
Figure 12. Routage physique de la Carte d’Evaluation LiveDesign 

Alimentation électrique  
La Carte d’Evaluation LiveDesign est alimentée par une alimentation régulée 5 volts (incluse). En règle 
générale, la Carte d’Evaluation LiveDesign, en l’absence de composants d’extension, nécessite une 
alimentation de 100 à 500 mA. Si la consommation totale de courant d’une Carte d’Evaluation 
LiveDesign avec des composants d’extension connectés est supérieure à l’unité standard 5 volts, il 
peut être nécessaire de recourir à une alimentation de capacité plus importante. La source 
d’alimentation en question devra fournir du courant alternatif 5 volts régulé. 

La Carte d’Evaluation LiveDesign comporte des régulateurs qui offrent différentes tension en fonction 
du FPGA cible. Par exemple : +3,3 volts, 1,2 volts et 2,5 volts pour la Spartan-3 et 3,3 volts et 1,5 volts 
pour la Cyclone. Les bus d’alimentation 3,3 volts et 5 volts peuvent tous deux être sélectionnés pour 
alimenter différents composants d’extension que vous pouvez brancher sur la Carte d’Evaluation 
LiveDesign. 
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Les périphériques  
La Carte d’Evaluation LiveDesign possède différentes ressources, chacune étant câblée aux broches 
d’E/S du FPGA cible. En plus de pouvoir servir de base au développement de nouvelles applications, 
ces périphériques permettent d’exécuter un large éventail d’exemples embarqués sur la Carte 
d’Evaluation LiveDesign. Les composants de la bibliothèque de schémas sont fournis pour permettre 
d’intégrer facilement les ressources dans les conceptions. Ces composants sont proposés dans la 
bibliothèque intégrée ‘Port-Plug-in’ de la Carte d’Evaluation LiveDesign du FPGA. Une image de 
chaque composant est donnée avec les descriptions suivantes. 

Les composants de la bibliothèque établissent automatiquement la connectivité entre la ressource et 
les broches d’E/S du FPGA, ce qui permet de construire une seule et même conception pour les FPGA 
de différents constructeurs. Le ‘Configuration Manager’ (Gestionnaire de configuration) permet de 
destiner un même projet à différents FPGA. Les composants de bibliothèque peuvent être placés dans 
la conception FPGA à partir de la bibliothèque 
\Program Files\Altium2004\Library\Fpga\FPGA EvalBoard Port-Plug-in.IntLib. 

Des exemples spécifiques sont inclus dans le dossier \Program Files\Altium2004\Examples\Carte 
d’Evaluation LiveDesign\ afin d’illustrer l’utilisation de ces périphériques.  

Horloge système  
La Carte d’Evaluation LiveDesign comporte un générateur d’horloge qui assure une fréquence de 50 
MHz. Le signal d’horloge est disponible dans le FPGA, autrement dit il est connecté à une broche 
FPGA GCLK (horloge globale). 

 
Figure 13. Horloge 50 MHz fixe  
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RAM statique  
La Carte d’Evaluation LiveDesign comporte deux composants RAM statiques 256k x 16 (SRAM0-U5 et 
SRAM1-U6), directement reliés aux broches d’E/S du FPGA cible. Les composants SRAM sont câblés 
individuellement aux broches d’E/S du FPGA, de telle sorte que l’IP du FPGA peut configurer la SRAM 
de différentes manières. 

La ressource mémoire peut être configurée par l’application en tant qu’un espace de 256k x 32, deux 
espaces 256k x 16, ou un seul espace 512k x 8. Les SRAM 256k x 16 ont un temps d’accès de 10 nS.  

 
Figure 14. SRAM sur la carte, U5 & U6 
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CONNECTEURS UTILISATEURS A et B 
Un total de 36 signaux d’E/S FPGA sont reliés sur les 20 broches des connecteurs, CONNECTEURS 
UTILISATEUR A (HDR1) et CONNECTEURS UTILISATEUR B (HDR2), soit 18 signaux par 
connecteur. Ces derniers sont composés également d’une terre et d’une alimentation 3,3 ou 5 volts, 
qui peut être sélectionnée à l’aide respectivement des connecteurs de sélection 4 broches JP1 et JP2. 

Les CONNECTEURS UTILISATEUR A et les CONNECTEURS UTILISATEUR B permettent 
d’interfacer le matériel défini par l’utilisateur avec le FPGA. Les broches d’E/S des connecteurs 
utilisateur peuvent être configurées comme étant soit des entrées, soit des sorties. 

Une gamme de composants dotés de connecteurs d’interfaces IDC 20 broches compatibles peuvent 
être obtenus auprès de différents constructeurs de cartes de développement. Pour de plus amples 
informations, veuillez vous reporter à www.altium.com/dxpcentral. 

Figure 15. Branchement des broches d’E/S utilisateur 
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Port série RS232 
J4 (DB9F) comporte un port DTE RS232, avec des signaux TXD, RXD, RTS et CTS. Ces signaux 
proviennent du FPGA de la Carte d’Evaluation LiveDesign. Chaque signal TX, RX, RTS ou CTS 
comporte un voyant lumineux qui permet d’observer les données du RS232. La conversion au niveau 
du RS232 est assurée par un composant MAX3232. Pour de plus amples informations sur ce 
composant, veuillez vous reporter au site web de Maxim, à l’adresse www.maxim-ic.com. 

 
Figure 16. Port RS232 (J4) 
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Ports clavier & souris  
J2 & J3 (MINIDIN) comportent des ports PS2 standard, destinés à être utilisés pour un clavier ou une 
souris de PC. Ces ports sont connectés directement aux broches d’E/S du FPGA. 

 
Figure 17. Ports PS2 

Port VGA   
J5 (DB15) comporte un port de moniteur vidéo RGB compatible VGA. Ce port est configuré avec trois 
bits par couleur ; au total, il a 9 bits par pixel, soit 512 couleurs. Le port est connecté directement à 9 
broches d’E/S du FPGA. Deux broches d’E/S complémentaires du FPGA fournissent les signaux de 
synchronisation verticale et horizontale au connecteur VGA. 

  

 
Figure 18. Port VGA (J5) 

 

For example: 
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Système audio  
La Carte d’Evaluation LiveDesign contient une chaîne de sortie audio stéréo Delta-Sigma, dotée d’une 
fiche de sortie stéréo 2,5mm (J1), une prise pour casque 2,5mm (J6) et deux hauts-parleurs miniature, 
SPKR1 et SPKR2. Le casque/amplificateur intégré fournit 100mW par canal. Le contrôle du volume est 
assuré par le potentiomètre P1 pour le casque et les hauts-parleurs. 

    
Figure 19. De gauche à droite : fiches de sortie stéréo et casque, haut-parleur, contrôle du volume, pack de 
résistance inline. 

 

Le taux d’échantillonnage Delta Sigma est entièrement 
déterminé dans le FPGA en fonction de l’application audio. 
Chaque canal audio comporte un filtre de sortie dont la 
fréquence d’angle peut être réglée en introduisant, dans les 
fiches IC prévues à cet effet, un pack de résistance inline 
unique (RN1 et RN2) doté de cinq résistances de valeur 
égale. La Carte d’Evaluation LiveDesign a une fréquence 
d’angle de 10kHz, mais celle-ci peut être ajustée à travers  
une large gamme. 

Modules de voyants lumineux 7 segments  
La Carte d’Evaluation LiveDesign est dotée d’un afficheur 6 chiffres, 7 segments. Chaque segment ou 
virgule décimale est contrôlé par une broche de sortie du FPGA.  

 
Figure 20. Afficheur 6 chiffres, 7 segments 
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Ensemble de touches clavier 
L’utilisateur peut saisir des données à l’aide des touches clavier, constitué de six boutons-poussoirs 
miniature (SW1 ... SW6) qui se présentent en matrice 1 x 6. Chaque bouton est connecté à une broche 
d’entrée du FPGA et est recouvert d’un revêtement blanc, sur lequel sa fonction peut être indiqué au 
marqueur. 

 

 
Figure 21. Six boutons de saisie utilisateur 

Commutateur DIP utilisateur  
La Carte d’Evaluation LiveDesign comporte un commutateur DIP 8 voies S1, dont chaque 
commutateur est relié à un signal d’E/S du FPGA. Le commutateur DIP est câblé à un composant  
actif bas. Autrement dit, lorsque le commutateur est sur ON, le signal produit est faible. 

 
Figure 22. Commutateur DIP 
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Sorties de signal de voyant lumineux   
La Carte d’Evaluation LiveDesign comporte 8 voyants lumineux rouges (LD0 ... LD7), chacun étant 
contrôlé par un signal distinct du FPGA. Les signaux des voyants lumineux sont actifs hauts. 
Autrement dit, un niveau élevé de signal allume le voyant concerné. 

 
Figure 23. Tableau de voyants lumineux 

La Carte d’Evaluation LiveDesign comporte également un voyant lumineux marqué LOADED au-
dessus du bouton TEST/RESET. Ce voyant s’allume chaque fois que le FPGA cible est configuré 
correctement. (LED2)   

Bouton TEST / RESET défini par l’utilisateur  
La Carte d’Evaluation LiveDesign comporte un bouton (SW7) marqué TEST/RESET qui est relié à  
un signal d’E/S du FPGA. La fonction de ce bouton est entièrement déterminée par l’application de 
l’utilisateur. Autrement dit, ce bouton n’as pas de fonction intrinsèque, à moins que celle-ci ne soit 
définie par l’application. 

       
Figure 24. Bouton TEST/RESET 
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